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Release Notes

Advanced Design System 2022 Update 1.0 Release Notes

For general information about Advanced Design System (ADS), visit ADS webpage at http://
www.keysight.com/find/eesof-ads.

[ 05 Starting ADS 2022 release, support for the following operating systems has been discontinued:

= Windows 7 Enterprise
= RedHat Linux RHEL 6.x
= SuSe Linux SLES 11

For more information, refer to Supported Platforms.

Contents

= Feature Updates
= Known Issues

Feature Updates

= File and Workspace Management Tools
= Design Editing and Layout
= Data Display

= Circuit Simulation

= HSD Design

= EM Simulation

= Verification

* Design Kits

= Power Electronics

= Signal Processing

= Virtual Test Bench (VTB)

= Installation

= Licensing

= Documentation

File and Workspace Management Tools

= AEL Interfaces
> ADS platform's Message List docking window, used to display error or warning messages, is
enhanced to accommodate arbitrary textual information. The text is presented with a leading
"INFO:" tag. A new AEL API, info_message(), can be used to send the textual information to the
Message List docking window.
> New AEL API, de_archive_workspace(), is added for archiving a workspace. For more information,
see Workspace Management Functions.

n Back to Feature Updates
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Design Editing and Layout

« General Enhancements

o

o

Technology Scale Factor, an advanced feature used to scale instances in multi-technology
workflows, can now be applied at the individual Smart Mount Pcell's cell level. For more
information, see DXF Functions.

Route spiral traces can easily be done with Trace > Avoid obstacles when routing (H)>Avoid same
net (N) setting turned on.

Enhanced Plane tool to support hierarchical global nets.

Enhanced Design Differences tool to update parameters for all the components using a single
command.

Enhanced layout translators — ODB++, ABL, BRD and Gerber—to preserve arcs in paths and traces.

= AEL Interfaces

o

DXF translations can be fully automated via a new set of AEL APIs. For more information, see DXF
Functions.
A set of AEL APIs to enable options setting for GDSII translations launched from AEL APIs. For
more information, see GDSII Functions.
A set of AEL APIs to get and set attributes of OA vias, and to set the "Default" and "Stackable"
parameters of an OA via definition. For more information, see Via Functions - OA.
New AEL API, stack_trace(), is added for retrieving the AEL call stack information upon the
invocation of this function call.
New AEL API, getpid(), is added to retrieve the process ID for the ADS platform process.
New or revised AEL APIs that enable Design Context to be specified:
= New AEL API, db_add_text_ex(), for creating text object in the specified designContext.
= New AEL API, db_convert_to_polygon_selected(), for polygon conversion operation to be
performed on the selected objects in the specified designContext.
= New AEL API, db_flatten_selected(), for flattening operation to be performed on the selected
objects in the specified designContext.
= New AEL APIs, db_mirror_x_selected(), db_mirror_y_selected(), and
db_copy_and_paste_selected(), for editing operations to be performed on the selected objected
in the specified designContext.
= de_boolean_logical_ex(), db_export_design(), de_crop() and de_union() enhanced to optionally
take in designContext as a parameter.

Back to Feature Updates

Data Display

= General Usability Enhancements

o

o

A Message List docking window is newly introduced to Data Display window and can be optionally
turned on or off. This window is where Data Display related error or warning messages are
presented.

The display properties of Legend data can now be configured by Legend's Options dialog box. The
properties may be accessed by double clicking on the legend you want to change. For more
information, see Changing Legend Properties.
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> The display properties of the labels for swept values can now be configured in the Trace Options
dialog box. The properties may be changed by selecting the "More..." button next to the "Display
Label" checkbox on the Linear tab in the Trace Options dialog.

= Data Viewing, Analysis and Manipulation

> Limit Lines now change color to indicate a pass or fail state. The Limit Line options dialog allows
you to change the color, line type and thickness of the Limit Line pass or fail states. Limit Lines
also support a pass/fail expression allowing you to create custom expressions that utilize the pass
or fail state. For more information, see Limit Lines PASS or FAIL States section under Plots and
Lists page.

> Limit Lines and Masks can be dragged from the Expression Manager, and dropped into existing
rectangular plots or for creating a new rectangular plot.

> |Improved Expression Manager in organizing the objects in a Data Display, the data within a dataset,
in presenting multiple datasets, in showing the detail information of a variable, and in its interaction
with Variable Explorer.

° Improved Variable Explorer in presenting the contents of selected Variable(s).

° Fixed a Data Display crash when creating a quick plot window (Autoplot).

For more information, see Data Display.

Known Issues

Back to Feature Updates

Circuit Simulation

= General
> Support of the Version 1.4 of BSIM BULK 106.2 (tmemod=1.4)
> HiSIM2 Version 3.11 is now supported.
° In Circuit Envelope, the fitting of S-Parameter data has been improved to be consistent over all S-
Parameter formats description and grid (Citifiles, SIO, Touchstone,...).
> Two Josephson junction devices are now available in ADS 2022 Update 1.0
= One has two terminals, the other three. Though they behave identically, the third pin allows to
observe or adjust the internal quantum phase of the device.
= Obsolescence Announcement.
> The RF System Budget Analysis will be deprecated in ADS 2022 Update 2.0, and removed in ADS
2023.
* ElectroThermal
> ETH_USER_DEF_TRSTEPS: Support of multiple test benches in same workspace. Each test bench
may use a different arbitrary timestep file
named <LIB>_<CELL>_<VIEW>_ETH_OUTER_STEP_TIMES.
> Smart mount is supported for Electrothermal (ETH) simulation (excluding the thermal Floor-
planner).

Known Issues

Back to Feature Updates
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HSD Design

= SerDes

o

o

o

o

Added TDR/TDT capability to S-Parameter Toolkit.

New JMPOutput component that generates .csv file with input variables and simulation results
used in JMP for Design of Experiments (DOE) analysis.

Added the capability to load .setx configuration file for FlexDCA and Infiniium probes.
Supports additional jitters in ReTimer_AMI components in Channel Simulation.

* DDR/Memory

o

New CA/Data Bus Designer beta product that helps designer engineers quickly build pre-layout
designs for CA and Data bus.

Added TDR/TDT capability to S-Parameter Toolkit. Improved the calculation speed for S-Parameter
Causality check by multi-threading.

Memory Designer now supports new DRAM type, NAND Flash.

Added Single-Ended PAM4 eye height and eye width measurements to Design Exploration in
Memory Probe.

Supports memory interface simulation report generation in HTML format from "Design
Exploration". The report will produce pass/fail data against user-entered limit values and plot any
measurement specified in Memory Probe.

New PCle AMI Model Builder that generates Tx and Rx AMI models for PCle applications.
Improved smart component's wire connection with edge snapping.

Added new VRM (Voltage Regulator Module) option to Memory Controllers and Memories.

FIR taps entry method for equalization is added to the Tx model setup in Memory Designer.
Improved DDR_Termination component warning when the associated PCB data is missing.

= EM-SIPro/PIPro

o

o

SIPro
= Speed grades for GDDR6, GDDR6X and GDDR7 have been added to the DDR setup.
= Port editing is made easier. You can now drag and drop a pin onto an existing port pin to have it
replaced. The polarity of the port pin will be preserved.
= Automated passivity check and passivity enforcement for SIPro S-parameter models, ensuring
passive results in the calculated frequencies
= Improvements in coplanar ground detection in the RapidScan extraction
= Full support to incorporate surface roughness effects, including support for the Huray model.
PIPro
* New W3036E Conducted EMI (CEMI) for PIPro product is shipping with ADS2022 Update 1.0.
PIPro CEMI Analysis includes dynamic switching models of the VRM that enable a full
Conducted EMI test bench to be run from within PIPro or exported to ADS schematic. W3036E
ships with Harmonic Balance to enable fast simulation of steady state time domain ripple and
conducted EMI spectral content. The licensing element is e_pwd_pi_emi.

* Obsolescence Announcement

o

The Encrypted HSPICE is obsoleted.

Known Issues

Back to Feature Updates
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EM Simulation

* RFPro Platform Improvements
> HFSS Link
= Dot pins on an edge and edge pins (on an edge!) will be translated to an HFSS EdgeTerm. The
HFSS Port Type will be set to 'Gap'. This is the equivalent of the FEM sheet port.
* The HFSS DeembedParasiticPortinductance flag will be enabled when the port's FeedType !=
DeltaGap.
> Port editing is made easier. You can now drag and drop a pin onto an existing port pin to have it
replaced. The polarity of the port pin will be preserved.
> Design parameters from the top level OpenAccess or 3D EMPro component instances can be
modified in RFPro what allows analyzing their impact.
* RFPro EM Solver Improvements
° FEM Generation 2
* An issue has been fixed in RFPro-FEM Generation 2 to properly account for the conductivity (or
resistivity) of sheet conductors.
= RFPro-FEM Generation 2 now supports surface roughness.

Known Issues

Back to Feature Updates

Verification

= Design Rule Check
> ADS DRC supports over 40 new rules, including aspect ratio and center-point spacing.
> The rules syntax is simplified with single-word qualifiers.
> Polygon selection rules produce notes that show the actual value produced by the rule.
> DRC can be run on LVS Device Recognition rules. Device, pin and artwork layers appear as DRC
errors and can be highlighted in the layout.
> Performance improvements.
For more information, see Design Rule Checker (DRC).
* Layout Versus Schematic
> |Improved highlighting of LVS errors such as unmatched nets.
> Component artwork can contain a pad stack with or without an additional area pin.
= For more information, see Layout Versus Schematic (LVS).
= PDK Validator
> PDK Validator can be configured to create test cells with more combinations of instance
parameters.
> Progress dialog shows information on which tests are running.
> Cancel button is more responsive.
For more information, see PDK Validator.

Known Issues

Back to Feature Updates
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Design Kits

= The "iso" layer thickness was modified and set to 4nm. in the substrate file.
Since the "iso" layer was already defined as a "sheet", this change in the thickness will not impact the
EM results; the results will remain the same as before.

Known Issues

Back to Feature Updates

Power Electronics

* PEPro

> New AC-DC test benches added for Voltage Spikes, Conducted EMI and Radiated EMI results.
> Speed up of 3D field data loading while visualizing Far Field results.
> Speed up of Circuit Simulation Dataset loading in the Near Field and Far Field results.

« Netlist Translator

> Added support to expressions in SPICE compatible Inductor elements.

> Added support to an additional syntax when values are not enclosed in curly brackets, in SPICE
compatible Capacitor elements specified in terms of their charge.

> Added support to node names with special characters in SPICE compatible Capacitor elements.

> Added a new translation rule to handle accuracy issues in ADS simulations when a SPICE
compatible equation is in the form log(1+exp(x)).

> Added support to handle log functions with complex arguments during netlist import.

> Added support to an additional syntax where function name and its body are separated by an '='in
SPICE compatible .FUNC statements.

> Added support to translate SPICE compatible limit functions to ADS built-in limit_warn function,
eliminating the need for including spice functions file during its simulation.

> Added support to node names with special characters in SPICE compatible Voltage Controlled
Voltage Source and Voltage Controlled Current Source elements.

° Fixed warning message statement while importing a SPICE compatible MOSFET model card with
its Length or Width specified.

> Fixed a bug where an additional comma was added to the end of the line while translating a SPICE
compatible Options statement.

> Fixed a bug where unrecognized characters were sometimes printed in warning messages during
netlist translation.

> Fixed a bug where an additional comma was added to the end of the line while translating a SPICE
compatible Options statement.

= Examples
> Added a new example to demonstrate the use of PEPro in simulating Single_Phase_Inverters i.e
Half_Bridge and Full_Bridge inverters. Inverter is designed using PE library Components. For more
information, refer Simulation of Single_Phase_Inverter Using PEPro.

10
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> Added a new example to demonstrate the use of PEPro in simulating Three_Phase_Inverter.
Inverter is designed using PE library Components. For more information, refer Simulation of
Three_Phase_Inverter Using PEPro.

- Power Electronics Library

> Added Voltage Tolerance and Time Tolerance parameters to Logic Gates. For more information,
refer LTspice Compatible Logic Gates.

Known Issues

Back to Feature Updates

Signal Processing

= Obsolescence Announcement
> The DSPSource related features (e.g. DSP_To_ARF, 3GPPFDD_Dn/UpLink_src, TDSCDMA_Dn/
UpLink_Src, WLAN_802_11a/b_Src) is deprecated and will be removed in ADS 2023 release.

Back to Feature Updates

Virtual Test Bench (VTB)

For general information about Virtual Test Bench (VTB), visit the VTB webpage at http://
www.keysight.com/find/virtual-test-bench.

= From ADS 2021:
o Verification Test Bench (VTB) is now called Virtual Test Bench (VTB).
° To install files that are required for the VTB functionality along with the ADS installer, you need to
download a separate VTB installer for both Windows and Linux and manually install the VTB.
> |f you have already installed ADS and find VTB functionality is missing, then you need to download
and manually install the VTB.

> |If you want to uninstall, then you need to manually uninstall VTB separately for both Windows and
Linux.

For more information, see VTB documentation.

Known Issues

Back to Feature Updates

Installation

= The ADS LAN client installation functionality has been removed from the future ADS releases.
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= Year changed in help menu from 1985-2021 to 1983-2021 matching with ADS Launch start year i.e
1983-2021.

Known Issues

Back to Feature Updates

Licensing

= ADS requires: a) the version 2021.02 of the EEsof EDA licensing software, b) a minimum code-word
version 2021.02 or above, and c) the licensing server software, Imgrd and agileesofd, to be upgraded
to at least the same versions as what are included in EEsof EDA Licensing software 2021.02 ADS will
not start if any of these requirements is not met. Refer to the License Codeword Version Compatibility
Table.

= In the EEsof EDA License Tools version 2021.02, licensing vendor daemon (agileesofd) is integrated
with FlexNet FNP 11.16.5.1 version (Windows) and FlexNet FNP 11.16.5.1 version (Linux) of FlexNet
license manager daemon (Imgrd). For the Windows platform, ADS installer will automatically set up
these two new license server daemons by default for the local node-locked license users; for the Linux
platform, you need to follow the Setting Up Licenses on Linux instruction to complete the licensing
configuration process. For more details, refer to Licensing (For Administrators).

Known Issues

Back to Feature Updates

Documentation

The online help gets a new user interface (Ul) that brings new features and enhanced usability.
Using the new features, you can do the following among many other things:

= Access most accessed topics in the documentation from the new Home page.

= Browse and use the online help on all device sizes like mobiles, tablets, laptops, and desktops.
= Refine search queries right from the documentation.

= Filter pages in the navigation tree using keywords.

= Apply dark theme.

= Change hyperlinks color.

= Copy code samples with a click.

= Copy links to sections with a click.

= Use keyboard shortcuts to use different features of the user interface.

= Use QR code to open any page on mobile and tablets.

For more details, see How to Use Online Help.

Additionally, the offline help now lets you create PDFs on-the-fly while you are connected to the
internet using the PDF button on the top-right corner of pages.

Known Issues
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Back to Feature Updates

Known Issues

Design and Technology Management

Cadence Virtuoso IC version 6.1.7 is not supported on RHEL 8 platform.
Using ADS 2020 with pycell studio 2018 (PyCell Studio Packages: Release 0-2018.09) might prompt
you an OA version mismatch warning message on the linux terminal. However, there is no impact on
the iPDK flow in ADS.
Linux terminal message:
Requested minor API version '518', which is supported by OpenAccess build '22.50.030' is newer than
the minor API version '514' of the shared library of OpenAccess build '22.50.043'".
The Express Pcell plugin that comes with Virtuoso IC version 6.1.8 does not work with ADS 2020 due
to an OpenAccess version mismatch, but the Express Pcell plugin will work with ADS 2020 Update 1.0
and 2.0.
Workarounds:
> When running ADS 2020, set the LD_LIBRARY_PATH environment variable path to point to the
directory from IC version 6.1.7.
> Upgrade to ADS 2020 Update 1.0
The Express Pcell plugin that comes with older versions of Virtuoso IC version 6.1.7 may crash during
a simulation with ADS 2020 Update 2.0 due to a third party incompatibility but may work with newer
versions above IC version 6.17_722 and up.
AEL constants are protected and should not be modified in any DDS expressions. An AEL error will be
issued in case an attempt to modify an AEL constant occurs.
Python Datalink
> When using Connection Expert 2019 connected to Lan Instruments, there may be error messages
during dl_visa_query() and dI_visa_write().
> Exceed on Demand: Note that in some cases, EoD settings may need to be configured to properly
display Spyder. Please contact your EoD support representative for additional guidance.

Back to Feature Updates

Design Guide

13

Unable to unarchive HDMI design guide from the Schematic view (DesignGuide > HDMI).
Workarounds:

> Unarchvie using the old ADS version.

> HDMI design guide will open in case it is already unarchived.
Simulating the "1_Sim_CA" design in the DDR4 CTB design guide prompts the netlist error.
Workaround: Open the schematic design "PatternGen_CA_Continuous" and arrange the pin numbers
in order.
Simulating of schematics in the HDMI_Link_Simulation design guide prompt the netlist error.

Workaround: Open the schematic design “HDMI_Diff_RX" and arrange the pin numbers order in order.
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Design Kits

* A design created using ADS2020 Non-Linear Demo Kit (NLD) and using NLD discontinuities like
demo_bendP, demo_stepP, demo_teeP, etc. will not work as expected in ADS 2021.
Workaround - In ADS 2021, either update the design with the latest NLD i.e. NLD shipped along with
ADS 2021; or continue to use the NLD that was shipped with ADS 2020.

Back to Feature Updates

Circuit Simulation

* General

o

o

When using GoldenGate in ADS 2020 Update 2.0, some of the library files of RFIC cockpit options
are not getting loaded due to license incompatibility. It is recommended to use ADS 2020 Update 1
when using GoldenGate in ADS.

For details on license compatibility, see License Codeword Version Compatibility.

Simulation Manager may not work on Windows and throw exceptions for some designs.

ADS 2019 will not be compatible with Verilog-A files, which have been encrypted before ADS 2019.
There is no change for non-encrypted Verilog-A files.

TMI models are supported for pure Hspice syntax only. The support of hybrid syntax (mixing
Hspice and Spectre) is planned for a future release.

BSIMSOI models using TMI modeling is not supported yet. Classical BSIMSOI models are
supported as before.

TMI Aging simulations are not supported

* ElectroThermal

o

In ADS, electro thermal simulation is assisted to automatically turn off the HBAHB and TAHB
options for single tone HB. However, the electro thermal simulation for multi-tone HB needs a
manual intervention to turn off the HBAHB and TAHB options for reporting voltage data.

You may not be able to start a Transient/Envelope Electro-Thermal (ETH) simulation only when the
same testbench is open in the viewer of Transient/Envelope thermal results. You need to close the
viewer before launching a Transient/Envelope ETH simulation.

The electrothermal simulation will not run on designs created using Smart Mount for Multi-
Technology feature.

Paths set while configuring the ETH controller may need to be updated when the workspace is
moved across operating systems.

On a fresh Linux machine, electrothermal simulation fails with the following error message:
Heatwave returned an unknown error code 127.

Workaround: The error could be due to missing packages, for example, libpng12. Verify your
system meets the requirements using the linux_sys_check.sh script. For more information,

see Checking Installed RPM Files and the Operating System Version.

If you get licensing errors while running thermal simulation, you may need the following
workaround.

Workaround: Rename the file $HOME/.eesofrc. For example, $HOME/.eesofrc-orig.
Electrothermal does not support remote simulation, batch simulation, Monte Carlo, tuning,
Optimization, and Measurement Equations. Also, you cannot sweep directly on the DC controller.
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> All libraries referenced in a layout should use the same layout resolution, namely the OA database
units (DBU) per user unit (UU).

> You cannot run both a transient and envelope simulation on the same design from one testbench.

> The calculation of power dissipation from passive components other than resistors may not be
correct in harmonic balance simulations.

> Electrothermal does not support the transient or envelope simulation that is controlled by a
ParamSweep.

° |f you get "Maximum timestep reduced to half of shortest transmission line delay " warning, it can
lead to transient simulation to not converge
Workaround: Unselect "Limit timestep for Transmission Line" option on Time Setup tab of Tran
component to get it work.

> On Linux, if you specify the THERMAL_DIRECTORY variable in eesof_lib.cfg file using backward
slash (..\thermal), the thermal simulation does not run properly.
Workaround: Specify the THERMAL_DIRECTORY variable using forward slash (../thermal) instead
of backward slash.

> The ETH viewer does not support 4K displays. A few instances of text and icons may appear
distorted.

> You receive an error message in substrate editor that you cannot use the same layer number more
than once. You can safely ignore this error during thermal technology export.

> 0On a fresh Windows 10 system, Electrothermal simulation terminates with an error.
Workaround: Install the following Microsoft Visual C++ runtime components:
http://www.microsoft.com/en-in/download/details.aspx?id=30679
https://www.microsoft.com/en-in/download/details.aspx?id=5555

= DDR Design

> You receive an error message to check port numbering when performing simulation with SnP
component for differential configuration.
Workaround: Select the first option in Pin Configuration for the SnP component.

Back to Feature Updates

HSD Design

= SerDes
° You receive an error message when runtime libraries for some of the ADS example ibs files (for old
AMI models) are unable to get installed automatically during the ADS install. The error appears
eventhough the ibs file is supported on specific platform.
Workaround: Microsoft Visual C++ 2010 runtime library is required to run the dl/ files. Download
the following library if it is not installed:
https://www.microsoft.com/en-us/download/details.aspx?id=14632
= EM-SI/EM-PI
° SIPro/PIPro, Via Designer
= On Windows 10 with Intel HD graphics, Via Designer may show an error message ‘Failed to use
the connection between ADS and Via Designer.” This has been isolated to the latest release of
Intel HD Graphics drivers (23.XX.XX.XXXX).
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Workaround: Downgrading the graphics driver to the previously recommended driver resolves
this issue (e.g., 22.20.16.4836, A05).

= DirectX 9 as a graphics driver is no longer supported. DirectX 11 is thus be used by default. Run
"diagdx" to verify which DirectX version is supported on your system.

° SIPro/PIPro

= ADS 2020 is not compatible with the latest available Samsung component models released in
June 2018. The support for the component models is planned to be added in an upcoming
update release.

= Simulation failure when using components with S-parameter models or for which the model is
defined using a lib/cel/view in case the Updating model does not require new simulation is not
set. As a workaround, turn on the option. For PI-AC simulations, the options are turned on by
default, for SIPro, this needs to be turned on explicitly.

= If you run SIPro/PIPro on a fresh machine with Suse 11 or Redhat 6 installed, you may
encounter the critical error "EMPro exited unexpectedly during execution." This is related to the
graphics driver software.
Workaround: Upgrade to the latest vendor-specific drivers and OpenGL libraries for the graphics
card.

Alternative workaround: Run the following commands:

cd SHPEESOF_DIR/fem/2020.20/1linux_x86_64/bin
./startempro --personality=sipi--driver=x11

Ignore any license-related error messages that may show up on executing these
commands. The driver setting is saved per personality for future sessions.

= With split domains on, there are no results available until simulation results are available from
the last simulation, or even after the simulation.

= Cadence® Allegro®(SPB 17.2 and SPB 17.4) is not supported on RHEL 8. As a result, the BRD
Import and ADFI Export does not work on RHEL 8.

> PIPro-DC
= The power graph is not correct when VRM's or Sinks are defined, starting from pin definitions.

All the other result data is correct. This issue does not occur when VRMs and sinks are defined
from component instances.

Back to Feature Updates

EM Simulation

= General

> ADS 2022 emSetup faces issues submitting jobs to a cluster when the "sitecluster behavior" is not
implemented in sitecluster implementation.

Workaround: Add a behavior function to sitecluster that returns {} as output on stdout.

> Cadence Virtuoso IC version 6.1.7 is not supported on RHEL 8 platform.

° |n a vncserver session running on an RHEL8.4 platform, you may encounter the critical error
"EMPro exited unexpectedly during execution." This is related to the graphics driver software
contained in the mesa-x.x86_64.20.3.3-2.e18 packages.

Workaround: downgrade the packages to the previous version using the following command:
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sudo yum downgrade mesa-x*

The packages mesa-*x-20.1.4-1.e18.x86_64, and the dependent llvm package work.
* RFPro
> The FEM and Momentum Generation 2 flows are state-of-the-art solvers but still evolving. In case it
does not handle your design, switch back to Generation 1.
> Multi-technology designs cannot be analyzed with Momentum.
Workaround: Use the FEM simulator
> Project load fails with the error 'OccDesign::getNet: key not found' when a layout shape has a multi-
bit net name (e.g. 'd<7:0>' or 'a,c,net1").
There is no workaround.
> With McAfee Endpoint Security (ENS) enabled, the Momentum surface current visualization hangs.
Workaround: Disable the "Enable Adaptive Threat Protection" flag in McAfee ENS.
= RFPro and 3D Viewer
> If the Geometry view is empty when opening the design, this may point to an issue with the
graphics card driver.
Recommended workaround: Upgrade to the latest vendor-specific drivers and OpenGL libraries for
the graphics card.
Alternative workaround 1: On Linux, launch the tool and force it to use the X11 driver. On Windows,
set the driver to 'msw'. This preference is saved for the current user and per personality. You can
do that by executing the following commands, e.g. in a shell on Linux:

cd SHPEESOF_DIR/fem/2021.10/1linux_x86_64/bin
./startempro --personality=rfpro --driver=x11
./startempro --personality=3dview --driver=x11l

Ignore any license-related error messages that may show up on executing these commands. The
driver setting is saved per personality for future sessions.

cd SHPEESOF_DIR/fem/2021.10/1linux_x86_64/bin
./startempro --personality=rfpro --clear-preferences
./startempro --personality=3dview --clear-preferences

For further troubleshooting with 3D libraries, refer to the following topics:
= Troubleshooting Blank Geometry Window
= Improving Graphics Performance in Remote Linux Environment
Alternative workaround 2: Set the following environment
variable EMPRO_SET_SOFTWARE_DRIVER_AS_DEFAULT=1. This variable controls the default
driver when no preference was set. On Linux, X11 is used. On Windows, MSW is used.
You can clear all preferences as follows:

* EM Setup

> On a Virtual Windows 10 system with Microsoft Hyper-V Video display driver, the 3D EM Preview
with EM Setup Preprocessing may bring up a dialog with a Hoops error, and, after suppressing the
dialog, it opens up blank.
There is no workaround.

> FEM based parallel jobs on sitecluster with behavior configuration (gbehave) may show
incomplete simulation logs.
Workaround: You can view the complete log available in the following location: <wrk_space>/
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simulation/<1lib>/<cell>/layout/emSetup_FEM/proj.ep/Simulation/<simulation_num>/
emds_dsn/design/emprfemx.log
= Distributed simulations
> The example implementation of the sitecluster command for LSF clusters may lead to failing

simulations if the path or number of threads is too large.
Workaround: See the workaround details in the sitecluster documentation.

Import/Export

> Exporting with MentorDA link does not work with the latest Mentor Graphics software Version
VX2.6.

Back to Feature Updates

Power Electronics

= PowerMOS_SiC power devices operate under a very wide range of voltage and current slew rates and
it is a challenge to create a model that converges under all conditions — especially conditions that
depend upon what components are connected externally to the power device in the circuit schematic.
Please contact technical support if you encounter such an issue when attempting to use this model.

= If you run PEPro on a new machine with Suse 11 or Redhat 6 installed, you may encounter the critical
error "EMPro exited unexpectedly during execution." This is related to the graphics driver software.
Workaround: Upgrade to the latest vendor specific drivers and opengl libraries for the graphics card.
Or
Run the following commands:

cd $HPEESOF_DIR/fem/2020.20/linux_x86_64/bin
./startempro --personality=sipi--driver=x11

You can ignore any license related error messages. The driver setting is saved per personality for
future sessions.

Back to Feature Updates

Installation

= While installing a new version of ADS, if you see “Previous version detected” error even after you have
already run the uninstaller for that version of ADS, you may need to manually uninstall ADS before
installation of the new ADS. To manually uninstall ADS, perform the following steps.
a. Exit the current ADS installation session if it is running
b. Remove or rename the file .com.zerog.registry.xml under the folder C:\Program Files\Zero G
Registry . Both the folder and the file are by default hidden, so you may need to change the folder
viewing setting to show hidden files and folders, do so via the Advanced settings of the View tab in
the Windows Folder Options dialog box.
c. Remove the ADS installation directory through the Windows Explorer.
= After performing the above steps, you can re-start the ADS installer.
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Back to Feature Updates

Licensing
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You may observe additional License Usage when Client Machine reconnects to network after
intermittent disruption.
Workaround: In case of network interruption on the client machine, to reclaim the inactive licenses, a
TIMEOUT can be set using the TIMEOUTALL feature in options file (minimum time period of 15
minutes). The inactive license may stay checked out for this period of time
Unable to install Licensing Hardware Key Drivers on Windows.
Workarounds:

° Turn off UEFI Secure Boot (BIOS) and use the default 6.3 version of the Wibu key driver delivered

with the EEsof Licensing tools.

> Turn on UEFI Secure Boot (BIOS), upgrade to ADS 2020 Update 2.0 and use the 6.51 WibuKey
driver version available in the 2020.02 License tools installation directory.

You will not be able to run older ADS releases with the 6.51 WibuKey dongle drivers

You may observe issue in recognizing more than one FLEXID on Linux platform with the 2020.02

license tools.

Workaround: Consolidate your licenses to one FLEXID and configure the same.

Setting FLEXLM_DIAGNOSTICS to the highest level (FLEXLM_DIAGNOSTICS=3) on Windows client

may cause a crash during license checkout. Flexera is investigating this issue.

Workaround: It is recommended not to use the FLEXLM_DIAGNOSTICS on Windows clients or use it

at lower level (FLEXLM_DIAGNOSTICS=1 or FLEXLM_DIAGNOSTICS=2).

WibuKey 6.5 software driver is not supported on SuSe 11.

Workaround: Use the older WibuKey 6.30 software driver (WkRt-Lin-6.32.1504-500.x86_64.rpm).

Licensing may not support a license file path that is too long. This will likely occur when you have too

many license files.

Workaround: Remove some license files, move the license files to a shorter directory path or to

combine license files into a single file.

License Setup wizard may not be able to start license server with many license files. During setup, it

may lead to a situation where a command prompt window appears/disappears incessantly. This is

due to the fact that License Setup wizard is not able to start Imgrd with a long command line and may

get stuck in a loop.

Workaround:

a. Itis recommended to combine all license code words tied to same MAC ID into single license file
to avoid setting large number of license files.

b. Tryto use a shorter path to place license files.

c. If #1 and/or #2 does not help, start the license server (Imgrd.exe) from the command line
(e.g. Imgrd.exe -c <lic-file-path> -| <license_server_log.txt>) and then set
<PRODUCT>_LICENSE_FILE=<PORT-NUMBER>@Ilocalhost for product you want to use on same
PC.

Dongle drivers for Flex-10 dongles on Linux are release specific. Installing the latest dongle drivers on

Linux will function properly only for the most recent EEsof releases.

Workaround: Install and use dongle drivers as needed. If you need to run the most recent EEsof
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releases, use the latest Flex-10 dongle driver. If you need to use older releases, uninstall the latest
dongle driver and re-install the older dongle driver

= FLO and EEsof License setup are writing server logs at different locations. However, the EEsof server
log file location is updated in the License Manager > Environment tab.

= When multiple same-named INCREMENT lines of different version exist on the license server, few
advanced FlexNet options to reserve/limit licenses may not work properly.

= Product Selector “Check Availability” generates incorrect results (which leads to license failure) for
older releases when multiple date base versions of like-named bundles exist in the license pool.

= In Linux, Product Selector OK and Cancel Buttons locations are reserved.

= Starting from FlexNet Publisher 2015 (also known as version 11.13.1), the adoption of the best
practice of the least-privilege security therein results in the License Server related Windows Service to
run with the LocalService Account privilege (instead of the LocalSystem privilege as before.) Running
with the LocalService Account privilege, an executable can no longer access any files located in the
per-user specific type of folders. As aresult, any license file placed in those folders can no longer be
accessed by the License Server when the License Server is automatically started via the Windows
Service upon each PC reboot. For the local node-locked license, this would not result in any disruption
to the usage of EEsof applications; however, for the license installed on a network PC that is accessed
by multiple client PCs, this may cause EEsof applications not to start after the network PC reboots
Workaround: Store your license files in the Windows folders that are accessible by the LocalService
Account privilege. For example, C:\ProgramData or C:\users\public are both qualified choices. In
general, any folder that has the "Users" group listed in its Properties > Security page and this "Users"
group has the read permission enabled should work.

= Using the default port to connect to a license server may cause a delay when checking out licenses. If
no port is given in the license file, Flexera scans ports 27000 to 27009 to find the port. Starting from
FlexNet Publisher 2015 (aka version 11.13.1), the default timeout for the response from each port
increased from .1 seconds to 3 seconds.
To avoid the delay, KSM now issues licenses with port 27009 instead of leaving this blank. The EEsof
License Setup Wizard (from Licensing 2017.01 onwards) handles some common situations such as:
where it detects license file(s) without port, when users get a new license file with port 27009, or when

all license files for a vendor daemon does not have same port.

You will not be able to start the license server if all license files for a vendor daemon on a server
does not have same port.

Users who manually setup a license server or using EEsof License Setup Wizard with older licensing
bits may need to manually edit license files to comply with the following rules:

a. All license files for a vendor daemon on a server must use the same port (or all be blank).

b. Using the default port (blank) is allowed but may result in longer checkout times.

c. If setting up a network server, select an unused port that is not blocked by a firewall.
Workaround: If the user cannot change the port, or wants to use the default Flexera ports, the
environment variable FLEXLM_TIMEOUT can be set to .2 seconds (200000), to minimize the
performance degradation. However, if the network latency is an issue in your environment, you may
need to fine-tune this setting to minimize the general performance degradation while still
accommodating the network latency.

= Installation of EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX) may
hang at 4% (percentage vary based on the products) for few hours or even more on some specific
machines.
Workarounds:
> Disable Firewall setting in Anti-Virus Software installed on the PC.
or
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> Download and unzip process explorer from the below link and then invoke procexp.exe.
https://docs.microsoft.com/en-us/sysinternals/downloads/process-explorer
Right click on the wusa.exe process under <Product installer exe> and select KillProcess. Now it
will continue the product installation.
After installing EESof EDA tools (such as, SystemVue 2016.08, Genesys 2017.XX, or ADS 2017.XX)
successfully and try to invoke the software or License wizard, you may encounter “api-ms-win-crt-
runtime-I1-1-0.dIl"” missing error.
Workaround: Install the Update for Universal C Runtime in Windows . On Windows 64-bit system
systems, the file to install is x64 version of the Microsoft hotfix KB2999226. A copy of
the Windows6.1-KB2999226-x64.msu Microsoft 64-bit hotfix installer can be found under the C:
\Program Files\Keysight\EEsof_License_Tools\bin directory. The Microsoft hotfix KB2999226
can be found under the Update for Universal C Runtime in Windows page at https://
support.microsoft.com/en-us/help/2999226/update-for-universal-c-runtime-in-windows as well.
On a newly formatted RHEL system, the EEsof Licensing tools may fail to boot. This is because the
FlexNet Publisher 2015 requires a certain rpm
Workaround: Under the EEsof product installation directory, there exists a utility script named
"Linux_sys_check.sh" under the bin directory. Run this script to find out whether any rpm is missing;
run this script with a "-y" command-line option to also have all the missing rpms
automatically installed if you have the sudo or root privilege.
License server may stop recognizing Flex-10 dongle on some systems within a few hours after
starting
Workaround: If v6.10 or v6.11 is found and experience this problem then upgrade the WibuKey
drivers to v6.30/6.30b from Wibu Systems.
Unable to install Flex-10 driver if Flex-9 dongle is already plugged into a machine
Workaround: Before installing a Flex-10 driver for the first time, unplug the Flex-9 dongle.
There is a known FlexNet Publisher issue, whereby mixing node-locked codewords and floating
codewords in one license file can result in: a) Remote simulations not working or b) A second local
simulation not working in case the license is node-locked and also has incorrect version.
Workaround: It is strongly recommended that you do not mix node-locked codewords and floating
codewords in one license file nor in any configuration that ends up with node-locked codewords and
floating codewords both available on the same server. In other words, put the node-locked license and
the floating license on different servers, and point to the respective one based on what you need to
run.
If a user simultaneously runs two instances of a product and has mixed different versions of the same
codeword on one license server, extra licenses may be pulled and result in unexpected “Licensed
number of users already reached for this feature” errors.
Workaround: We recommend you remove expired codewords, to separate out the new and the old
versions of codewords into different files and different servers, and to point to the respective one
based on what you need to run.
Not specifying the TCP/IP port for the license server during license setup may lead to unexpected
behavior and/or license checkout failure on the Windows platform. We strongly recommend you to
always explicitly specify the TCP/IP port associated with each license server.
A node-locked and floating bundle operating on Linux cannot be shared between products using EDA
License Tools version older than 2014.01 when run at the same time.
License Setup Wizard does not remove any previous user-configured FLEX Windows License Service
manually set up by a user using FlexNet's Imtools.
Workaround: You must remove the previous user-configured Windows License Service via Imtools.
> Run the Imtools.exe from C:\Program Files\Agilent\EEsof_License_Tools\bin toinvoke the

Imtools utility. The Imtools utility window is displayed.
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If you have installed an EEsof product released before 15t August, 2014 on your system prior
to installing an EEsof product released after 78t August, 2014 then the default EEsof
Licensing tools path will remain C:\Program Files\Agilent\EEsof_License_Tools. On

the systems that only have EEsof products released after 15t August, 2014 installed then the
default EEsof Licensing tools path will be C:\Program
Files\Keysight\EEsof_License_Tools.

> In the Service/License File tab, check the Configuration using Services option. All user-configured
FLEX Windows License Services will be listed.
> Select the service you wish to remove.
> Select the Config Services tab and click the Remove Service button to remove the service.
To ensure that the license service or Imgrd is running, click View Log. A log window appears that
confirms whether agileesofd and Imgrd are up and running.
While running multiple versions of prior ADS releases together, set
ADS_MAXIMUM_BUNDLE_USAGE=0N in your environment so that all of them will use the same
method to check out licenses. Otherwise, you might receive an error message, "Licensed number of
users already reached".
On some Windows 7 machines, when more than one definition of an Ethernet adapter exists
(duplicates), license checkouts may appear to hang up.
Workaround: Disable the duplicate network card definitions in your network settings: Control Panel >
Network and Internet > Network Connections. This issue has been acknowledged by Flexera and they
have created a bug report (SIOC-000103097).
For LSF style distributed simulations, ensure that the PATH on the client computer points to the
SHPEESOF_DIR/EEsof_License_Tools/${architecture} directory that corresponds to the EEsof release
being used. This needs to be done in order to ensure that the proper version of the Flexera utilities
(like Imutil ) gets picked up in the path before any older in-compatible versions (that may also be
installed on a users’ system.)
License Setup Wizard ( agimwizard.exe ), which is used to set up and record the license path would
not work if you already have an environment variable set for ADS_LICENSE_FILE.
Workaround: You can use ADS_LICENSE_FILE variable to point to license file or refer to Licensing (For
Administrators).
The License Setup Wizard will exit or not properly configure a license server, if the server has all of its
licenses currently in use.
Workaround: Wait for a license on the server to become available as you normally would before
launching the product.
Unable to set license in case unicode characters are used either in path or license file name because
the Flex License Service does not support these characters.
The Product Selector tool will be unable to display the license server status properly when connected
to older license server.
Workaround: Upgrade your license server to the latest version.
EEsof Licensing Tools installer can hang on systems with McAfee LiveSafe installed and running the
default firewall settings.
Workaround: Prior to installing EEsof Licensing Tools, temporarily turn off the McAfee LiveSafe
firewall.
Licensing setup steps on systems with McAfee LiveSafe installed can fail.
Workaround: Under the McAfee LiveSafe firewall settings, under Port and Settings, allow the use of
port 27001 for Imgrd.exe under the EEsof Licensing Tools installation bin directory. Under Internet
Connections for Programs, enable Imgrd.exe, agimmgr.exe and aglmwizard.exe for all devices and
turn off monitoring.
On Windows, EEsof product releases prior to 2014 can have boot time issues with licensing if an
newer EEsof product is installed prior to installing the older product. For example, if a users installs
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Advanced Design System 2017 and then installs Advanced Design systems 2014.01, the user can
have boot time errors with ADS 2014.01.

Workaround: For Advanced Design System users, set a system environmental variable named
ADS_LICENSE_FILE under the Control Panel/ System, and Security / System / Advanced system
settings and under the "environmental variables". Add an System variable named
ADS_LICENESE_FILE and the value will be the path to your local license file or the port@host setting
for your site.

Back to Feature Updates

Third Party Applications

= Spyder application menu bar becomes inactive when the window is maximized using View > Full
Screen or by pressing F11 (shortcut key to maximize the screen).
Workaround: Press F11 again to make it the default screen. The menu bar is now active and works
fine.

Back to Feature Updates

Verification

= Cadence applications (Assura) is not supported in RHEL 8 Linux Distribution.

Back to Feature Updates

Virtual Test Bench

= From VTB 2021, SystemVue VTB's QT help file is integrated into SystemVue VTB installer. However,
help does not open, when you press F1 for a VTB component.
Workaround: Perform the following steps:

a. Open a command window.
b. Set the path to ADS help directory. Execute the following command:
On Windows

set path="<ADS_Install DIR>\bin\Help";%PATH%

On Linux

export PATH=<ADS_Install DIR>/bin/Help:$PATH

On RHEL 7 (due to library related issue)
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export HPEESOF_DIR=<ADS_Install DIR>

export LD_LIBRARY_PATH=$HPEESOF_DIR/1ib/linux_x86_64:$HPEESOF_DIR/
1ib/1inux_x86:$LD_LIBRARY_PATH

export PATH=$HPEESOF_DIR/bin:$PATH

export PATH=$HPEESOF_DIR/bin/HELP:$PATH

Where,
<ADS_Install_DIR> is the ADS installation directory.
On Windows: The default ADS location is "C:\Program Files\Keysight\ADS<version>"
On Linux: The default ADS location is "/usr/local/ADS<version>".
For example, <version> is 2022
c. Invoke VTB help. Execute the following command:
On Windows

assistant -collectionfile "<VTB_Install_DIR>\Help\vtb.ghc"

On Linux

export SYSTEMVUE_INSTALLATION_DIRS=xxx/SystemVueVTB/2021

assistant -collectionfile $SYSTEMVUE_INSTALLATION_DIRS/Help/vtb.ghc

Where,

<VTB_Install_DIR> is the SystemVueVTB installation directory on Windows.

xxx is the directory where unzip or untar of VTB package is done on Linux

On Windows: The default VTB location is "C:\Program Files\Keysight\SystemVueVTB2021"
You can also refer to the online version of the SystemVueVTB documentation.

= For SystemVueVTB 2020 Update 1, help does not open, when you press F1 for a VTB component. For

details, refer VTB documentation.
= When using VTB on Virtual Machine (VM), if SystemVue crashes then ensure to restart your system.
= To use VTB, ensure ADS is installed in a path that has only ASCII characters.
= VTB is not supported on the SuSe 11 platform.

= Backward compatibility
In ADS, the customized VTB can have a backward compatibility issue.
Workaround: To fix this issue, use one of the following methods:

a. Open and Save the custom VTB in SystemVue2020Update1. Now, you can use the custom VTB in
ADS.

b. A built-in workspace conversion tool is provided in the installer. You can convert the custom
workspace (.wsv) to the newer SystemVue version. Use the following steps to convert the
workspaces:
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= Open Command Prompt in the Administrator mode.
= Browse the location of the old workspace. For example, C:\ADS_VTB.
= Run the following command parameter.

C:
\ADS_VTB><SystemVueVTB_Installation_Dir>\bin\WorkspaceConversionTo
olManaged.exe" VTB_Examples.wsv VTB_examples_new.wsv

Where,
1. <SystemVueVTB_Installation_Dir> is the location where SystemVue VTB package is installed.
For example, C:\Program Files\Keysight\SystemVueVTB2020Update1.
2. VTB_Examples.wsv is old SystemVue file and VTB_examples_new.wsv is converted file.
c. The following successful message is displayed.
Created: VTB_example_new.wsv
d. You can now use the VTB_examples_new.wsv workspace in ADS.

= When multiple VTB versions are installed, the VTB package in the Library Configuration Editor remain
fixed to a particular VTB version. However, symbol view uses the correct VTB version.

= While migrating the same VTB component from one VTB package to another (example:
SystemVueVTB2020U1 to SystemVueVTB2021 or vice versa) using Swap Components option in ADS,
the enumerated parameters are not getting updated automatically to the default value.
Workaround: It is recommended that while swapping the component from one VTB version to another
VTB version, ensure to manually:
select the desired enumerated parameters before using the component
Or
select a new VTB component from the component palette using the required VTB package.

Back to Feature Updates

Examples - Known Issues

= Examples under <ADS Install Directory>\examples \Instrument_links folder are not getting opened on
Linux where as they are opening fine on Windows.
Workaround: Rename the ‘Instrument_links’ folder to ‘Instrument_Links’, if you have write permission
to the <ADS Install Location>\examples folder. In case you do not have the write permission
then proceed with manual unarchive process (File > Unarchive from the ADS Main window) pointing
to the Example workspace.

= Example search might not work and prompt you the "Database is locked" error when ADS installation
is on NAS.
Workaround: Restart the nfslock service on client. In case the problem still persists, reboot the client
to unlock the database.

= Unable to compile Pin Diode Model using Visual Studio 2012 on Windows 7 64-bit platform.
Workaround: Delete the contents of the
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directory examples\RF_Microwave\UserCompiledModel_wrk\ UserCompiledModel\1lib.win32_64
before using UCMs.

= An error occurs while running a custom VTB.
Workaround: Download and run a custom VTB from the following location: <ADS Install
Location>\SystemVue\2076.08\win32_64\VTB.

Back to Feature

Documentation

= On Windows, Printing directly from installed help generates non-readable output.
Workaround: Use the PDF version of the document for printing purposes.

= From 2017 onwards, in the installed help when you open a page using the "Open a link in new tab"
option the help does not open a page in a different tab by default. You need to set the preferences to
open any link in a new tab.
To set the preferences:
a. From the 201x version of the installed help, Click Edit > Preferences.

The Preferences Dialog box is displayed.

b. Select the Options tab.
c. Under Appearance, select the Show tabs for each individual page option.
This is a one-time setting for a particular release of a product.

= Unable to open online help, any external link, or Embedded Survey link in Linux on Mozilla Firefox
browser.
Workaround: Use Mozilla Firefox version 39 or above or keep the Mozilla Firefox window open and
then try to open online help.

= While using the installed help, you may encounter issues like help not showing any content, it throws
an error, it displays unexpected hierarchy in the Content tab, or it does not display any search results.
Workaround: Close the help, delete the contents of the following directory, and open the help again.

> On Windows:
C:\Users\<Windows_Login_ID>\AppData\Local\Keysight\Help

° On Linux:
* SHOME/.local/share/Keysight/Help
* SHOME/.cache/Keysight
* $HOME/.cache/rfdeqthelp
= The installed help search does not support [] or {} or any other text using these combinations.
= On Linux, Konqueror web-browser does not display the online help properly. It may not display help
pages at all or may display them broken and with errors.
Workaround: Use Mozilla Firefox to view the online help.

Back to Feature Updates
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